Rockwell Automation, Inc.
MicroLogix, SLC500 Series
DF1 Driver

Supported version TOP Design Studio V1.0 or higher {Rl

TOP

"

CONTENTS

We would like to thank our customers for using M2I's "Touch

Operation Panel (M2] TOP) Series". Read this manual and familiarize
yourself with the connection method and procedures of the "TOP and

external device”.

1. System configuration Page 2

Describes the devices required for connection, the setting of

each device, cables, and configurable systems.

2. External device selection Page 3

Select a TOP model and an external device.

3. TOP communication setting Page 4

Describes how to set the TOP communication.

4. External device setting Page 10

Describes how to set up communication for external devices.

5. cable table Page 11

Describes the cable specifications required for connection.

6. Supported addresses Page 13

Refer to this section to check the addresses which can

communicate with an external device.
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1. System configuration

The system configuration of the driver “Rockwell Automation — MicroLogix/SLC500 Series” is as follows:

Communication

Series Link I/F System setting
method
3.1 Settings
MicroLogix1500 h 1 RS-232C e 1 5.1. Cable table 1
anne - example -
(1764-LRP) (Page 9-(A))
(Page 4)
3.1 Settings
. ) 5.2. Cable table 2
MicroLogix MicroLogix 1000 Channel 0 RS-232C example 1 -
. . (Page 9-(B))
MicroLogix 1200 (Page 4)
MicroLogix 1500 AIC + 1761-NET- 3.1 Settings
5.3. Cable table 3
(1764-LSP, 1764-LRP) | AIC (Advanced RS-232C example 1 -
(Page 9-(C))
Interface Converter) (Page 4)
3.1 Settings
5.1. Cable table 1
Channel 0 RS-232C example 1 -
(Page 9-(A))
(Page 4)
SLC 5/03 1770-KF3 3.1 Setting
.1 Settings
SLC500 SLC 5/04 2760-RB RS-232C ple 1 2.3. Cable table 3
- example
SLC 5/05 1775-KA . 4 (Page 9-(D))
age
5130-RM
3.1 Settings
5.3. Cable table 3
1771-KGM RS-232C example 1
(Page 9-(E))
(Page 4)

W Connection configuration

- 1:1 (one TOP and one external device) connection

ko] — |

| Al

|'I:
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2. External device selection
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H Select a TOP model and a port, and then select an external device.

Timeout

Send Wait
DF1 Mode
Error Detection
Source ID
Destination ID (Remote) |1
MNAK Retries

ENQ Retries

Select Device n

PLC Setting[ MicroLogix Series ]

Alias Mame : |f3LC1

Interface : | Serial ~

Protocol : |DF1 ~ Comm Manual

String Save Mode : |First HL HL Change

[ use Redundancy

AND ~

Primary Option

[
=
=

4 | msec
-

msec

Full Duplex ~

[=1]

<

CC

II

[
Ak

[
Ak

@ Back + OK *® Cancel
Settings Contents
TOP Model Check the TOP display and process to select the touch model.
External device | Vendor Select the vendor of the external device to be connected to TOP.
Select “Rockwell Automation, Inc".
PLC

Select the model series of the external device that connects to the TOP.
Select "MicroLogix/SLC500 Series DF1".

Please check the system configuration in Chapter 1 to see if the external device you want to

connect is a model whose system can be configured.
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3. TOP communication setting
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TO,

The communication can be set in TOP Design Studio or TOP main menu. The communication should be set in the same way as that

of the external device.

3.1 Communication setting in TOP Design Studio

(1) Communication interface setting
M [Project > Project Property > TOP Setting] — [Project Option
— Set the TOP communication interface in TOP Design Studio.

> “Use HMI Setup” Check > Edit > Serial]

Project Option

- Change HMIH] | |l Add PLC [ T Change PLCIC] | [ Delete

X

PLC[D)

Communication Error Message=0
UUSBErrarMessage=0
StorageErrorMessage=1
DatabaseMessaoe=1

TOP Setti
an'g;!—r&gﬂllslux Date [ Time Sync. = Screen Option Unit Convert
8 Option Modie Setting Project Option  Screen Change = HmiSetup | Global Lock & Touch  Project Style  Splash | PLC Buffer Sync.
-4 FieldBus (0)
-8 RFID (0) se HMI Setup
v
o Device Setting =
g% COM1 (0) imi >&tp Uptian Initialization Edit
v m com2 (1) Project Setting ~
-1 PLC1: MicroLogix Series HMIDisable=0
g% COM3 (0) Project Name=New project
4 Ethernet (0) Start Mode=Menu
@ Wireless (0) f;[_ﬁcsf e No.=1
-4 USBDevice (0) Latch Set=0n0

Control Panel

3 Service

L<*! Opt jon

System m Devices

m Serial ®o
e !
1l I . Serial Port: | COM1 @
PLD Security Dat &/T ine Signal Level
(@) AS-232C (O RS-42204) O Rs-485(2)
Baud Rate: 33400 ©
(1] (1] —— .
I S8 o '\__/ Data Bit: & v
Et hernet Ser jal HIOM | Stop Bit: |1 >
Parity Bit: None M
I T % Flow: 0ff
L el . Ping
_ ; Auto Search  Loopback Test
Diagnost ic File Fing
Manager
Apply Cancel
Items TOP External device Remarks
Signal Level (port) RS-232C
RS-232C RS-422 RS-485
RS-422/485
Baud Rate 38400
Data Bit 8
Stop Bit 1
Parity Bit None.

* The above settings are examples recommended by the company.

Items Description

Signal Level Select the serial communication method between the TOP and an external device.

Baud Rate Select the serial communication speed between the TOP and an external device.

Data Bit Select the serial communication data bit between the TOP and an external device.

Stop Bit Select the serial communication stop bit between the TOP and an external device.

Parity Bit Select the serial communication parity bit check method between the TOP and an external device.
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(2) Communication option setting

TO,

M [Project > Project Property > Device Setting > COM> “PLC1 : Control/Compact Logix Series"]

— Set the options of the DF1 communication driver in TOP Design Studio.

ERI2 e B X
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Project Option

~ ] TOFP Setting

- 5YS ¢ RD1520%
Option Module Setting
B FieldBus (0)

- RFID (0)

. Device Setting

-rg¥ COM1 (D)

v g8 COM2 (1)
i [ PLC1: MicroLogix Seriesl

T
8 Ethernet (0)
™ Wireless (0)
¥ USBDevice (0)

- Change HMI[H] ' AddPLC[A] | THTM) Change PLCIC | [] Delete PLCID]

PLC Setting[ MicroLogix Series ]
Alizs Name : [PLC1

Interface : | Serial ~

Protocol : |DF1 ~
String Save Mode : (First HL HL Change

[] use Redundancy
AN

[=]
L

TimeQut 5

Ak

Condition

Primary Option

Timeout msec
Send Wait - msec
Full Duplex e
-
-
a

DF1Mode
Error Detection

Source ID

Destination ID (Remote)

MNAK Retries

EMNQ Retries

Edit

Apply Close

Comm Manual
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3.2. Communication setting in TOP
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* This is a setting method when “Use HMI Setup” in the setting items in “3.1 TOP Design Studio” is not checked.

W Touch the top of the TOP screen and drag it down. Touch “EXIT" in the pop-up window to go to the main screen.

(1) Communication interface setting

M [Main Screen > Control Panel > Serial]

Run

YNC
Yiewer

(i

Ethernet

Diagnost ic

[System]

Conitroll Panel

o serial

Serial Port:

Signal Level

® RS-232C O RS-422(4) O R5-485(2)

| COM!

Baud Rate: 38400
Data Bit: | 8
Stop Bit: | 1

Parity Bit: | None
Flow: [ Of f

= i

Items TOP External device Remarks
Signal Level (port) RS-232C

RS-232C RS-422 RS-485

RS-422/485

Baud Rate 38400
Data Bit 8
Stop Bit 1
Parity Bit None.

* The above settings are setting

examples recommended by the company.

Items Description

Signal Level Select the serial communication method between the TOP and an external device.

Baud Rate Select the serial communication speed between the TOP and an external device.

Data Bit Select the serial communication data bit between the TOP and an external device.

Stop Bit Select the serial communication stop bit between the TOP and an external device.

Parity Bit Select the serial communication parity bit check method between the TOP and an external device.
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(2) Communication option setting
M [Main Screen > Control Panel > PLC]

Bun

@ System
|

PLC S
[,J'Lll o
Ly =
Et hernet E

Diagrost ic

[

=

[System]

TOP

d

Interface | Serial Rd
Protocol | DF1 Rd
Timeout 300 13 msec
Send Wait MmSec
DF1 Mok
Error Det
source |C
Destinat =
NAK Retr |
ENQ Retri E =
Diagnostic ]

ERI2 e B X
Touch Qperation Panel

B — PLE

Dr iver (COMT) [ PLC1(Micrologix Series)

| tpp |y

| Cancel |
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3.3 Communication diagnostics

W Check the interface setting status between the TOP and an external device.
- Touch the top of the TOP screen and drag it down. Touch "EXIT" in the pop-up window to go to the main screen.
- Check if the port (COM1/COM2/COM3) settings you want to use in [Control Panel > Serial] are the same as those of the external

device.

W Diagnosis of whether the port communication is normal or not
- Touch “Communication diagnostics” in [Control Panel > PLC].

- The Diagnostics dialog box pops up on the screen and determines the diagnostic status.

OK Communication setting normal

Time Out Error Communication setting abnormal

- Check the cable, TOP, and external device setting status. (Reference: Communication diagnostics sheet)

B Communication diagnostics sheet

- If there is a problem with the communication connection with an external terminal, please check the settings in the sheet below.

[tems Contents Check Remarks
System How to connect the system oK NG ) )
) ) - 1. System configuration
configuration Connection cable name oK NG
TOP Version information OK NG
Port in use OK NG
Driver name OK NG
Other detailed settings oK NG
Relative prefix Project setting oK NG
Communication 2. External device selection
) ) OK NG . -
diagnostics 3. Communication setting
Serial Parameter Transmission
oK NG
Speed
Data Bit OK NG
Stop Bit oK NG
Parity Bit oK NG
External device CPU name OK NG
Communication port name (module name) OK NG
Protocol (mode) OK NG
Setup Prefix oK NG
Other detailed settings oK NG . .
4. External device setting
Serial Parameter Transmission
OK NG
Speed
Data Bit OK NG
Stop Bit oK NG
Parity Bit oK NG
Check address range 6. Supported addresses
OK NG (For details, please refer to the PLC
vendor's manual.)
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4. External device setting
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Set as below using “MicroLogix/SLC500 Series” Ladder Software “RSLogix 500". For more detailed setting method than that

described in this example, refer to the PLC user manual.

f Do not configure a duplicate Source ID (prefix) for the external device connected to the same unit

network

1. From the “RSLogix 500" window, double-click [Channel Configuration] to open the “Channel Configuration” window.

2. From the "Channel Configuration” window, select the [Chan. 0 -System] tab, and configure as shown below.

Setup Items Setup Description Remarks

Driver DF1 Full Duplex Slave Fixed

Baud Rate 19200

Parity NONE

Stop Bits 1

Source ID (Station Address) 0

Protocol Control Control No Handshaking Fixed
Error Detection BCC Fixed
Embedded Enabled Fixed
Duplicate Packet Detect No Check Fixed
ACK Timeout 50
NAK Retries 3
ENQ Retries 3

3. Download configurations to PLC.
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5. Cable table
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This chapter introduces a cable diagram for normal communication between the TOP and the corresponding device.

(The cable diagrams described in this section may differ from the external device vendor’s recommendations.)

W RS-232C (1:1 connection)
(A) TOP COM Port (9 pin)

TOP COM PLC
Pin Signal Pin Cable connection Pin Signal Pin
arrangement*Note 1) name number number name arrangement*Note 1)
1 5 CD 1 1 cD 5 1
(@ Q) RD 2 2 RD (© ©)
2 g SD 3 3 ) Q g
DTR 4 4 DTR 9
Based on Based on
N SG 5 5 SG .
communication communication
DSR 6 6 DSR
cable connector cable connector
front, RTS ! ! RTS front,
D-SUB 9 Pin male | TS 8 B CTS_ | D-SUB 9 Pin female
(male, convex) 9 9 (female, concave)
*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector.
(B) TOP COM Port (9 pin)
TOP COM PLC
Pin Signal Pin Cable connection Pin Signal Pin
arrangementNote 1) name number number name arrangement*Note 1)
1 5 CD 1 1 5 1
(© ©) RD 2 2 TXD (@ ©)
Q Q SD 3 3 RXD Q o
6 9 9 6
DTR 4 4
Based on Based on
S SG 5 5 SG L
communication communication
DSR 6 6
cable connector cable connector
front, RTS ! ! front,
D-SUB 9 Pin male | TS 8 8 D-SUB 9 Pin female
(male, convex) 9 9 (female, concave)
*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector.
(C) TOP COM Port (15 pin)
TOP COM PLC
Pin Signal Pin Cable connection Pin Signal Pin
arrangement*Note 1) name number number name arrangement*Note 1)
1 8 CD 1 1 5 1
U RD 2 2 RXD © 4
Q O D 3 3 XD Q )
9 15 9 6
DTR 4 4
Based on Based on
L SG 5 5 SG L
communication communication
DSR 6 6
cable connector cable connector
front, RTS 7 ’ front,
D-SUB 15 Pin male | C1° 8 8 D-SUB 9 Pin female
(male, convex) 9 9 (female, concave)

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector.
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(D) TOP COM Port (9 pin)
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TOP COM PLC
Pin Signal Pin Cable connection Pin Signal Pin
arrangement*Note 1) name number number name arrangementNote 1)
1 5 D 1 1 GND_ | 13 1
Q o RD 2 2 TXD o o
SD 3 3 RXD 25 14
6 9 DTR 4 4 RTS Based on
Based on G 5 I: 5 cTS communication
communication DSR 6 6 DSR cable connector
cable connector RTS . T_ 7 COM front,
front, p— 5 8 DCD D-SUB 25 Pin
D-SUB 9 Pin male 9 20 DTR female (female,
(male, convex) concave)
(E) TOP COM Port (9 pin)
TOP COM PLC
Pin Signal Pin Cable connection Pin Signal Pin
arrangement*Note 1) name number number name arrangementNote 1)
1 5 D L 1 SD 8 L
o ®) SD 3 3 RXD 15 9
6 9 DTR 4 4 RTS Based on
Based on SG 5 I: 5 CTS communication
communication DSR 6 T_ 6 DSR cable connector
cable connector RTS - 7 COM front,
front, TS 8 8 DCD D-SUB 15 Pin
D-SUB 9 Pin male 9 20 DTR female (female,
(male, convex) concave)
*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector.
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6. Supported addresses

TO,

ERI2 e B X
Touch Qperation Panel

The devices available in TOP are as follows:

The device range (address) may differ depending on the CPU module series/type. The TOP series supports the maximum address

range used by the external device series. Please refer to each CPU module user manual

and be take caution to not deviate from the address range supported by the device you want to use.

A Device notation

= Device Name File Number : Element

6.1 MicrolLogix Series

Device Bit Address Word Address 32 bits | Remarks
Output File 0000:000.00 — O008:255.15 0000:000 — O008:255
Input File 1000:000.00 — 1008:255.15 1000:000 — 1008:255
Bit File B003:000.00 — B003:255.15 B003:000 - B003:255
B009:000.00 — B255:255.15 B009:000 — B255:255
Timer File  Coil Done TC004:000.13 — TC004:255.13
TC009:000.13 — TC255:255.13
Timing TC004:000.14 — TC004:255.14
TC009:000.14 — TC255:255.14 -
Enable TC004:000.15 — TC004:999.15
TC009:000.15 — TC099:999.15
Preset - TP004:000 — TPO04:255
TP009:000 — TP255:255
Accumulated - TA004:000 — TA004:255
TA009:000 — TA255:255
Counter Coll Update Acc CC005:000.10 — CCO05:255.10
File CC009:000.10 — CC255:255.10 /M
Underflow CC005:000.11 — CC0O05:255.11
CC009:000.11 — CC255:255.11
Overflow CC005:000.12 — CC005:255.12
CC009:000.12 — CC255:255.12
Done CC005:000.13 — CC005:255.13 -
CC009:000.13 — CC255:255.13
Down Enable CC005:000.14 — CCO05:255.14
CC009:000.14 — CC255:255.14
Up Enable CC005:000.15 — CC005:255.15
CC009:000.15 — CC255:255.15
Preset CP005:000 — CP005:255
B CP009:000 — CP255:255
Accumulated CA005:000 — CA005:255
- CA009:000 — CA255:255
Integer File N007:000.00 — N007:255.15 NO007:000 — N007:255
N009:000.00 — N255:255.15 N009:000 — N255:255
Floating Point File - F008:000 - F255:255 H/L
String File - ST9:0 — ST255:255 LM
Long Word File L9:0/0 - L255:255/31 L9:0 — L255:255
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6.2 SLC 500 Series
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Device Bit Address Word Address 32 bits | Remarks
Output File 0000:000.00 — 0063:255.15 0000:000 — 0063:255
Input File 1000:000.00 - 1063:255.15 1000:000 — 1063:255
Bit File B003:000.00 — B003:255.15 B003:000 — B003:255
B009:000.00 — B255:255.15 B009:000 — B255:255
Timer File  Coil Done TC004:000.13 — TC004:255.13
TC009:000.13 — TC255:255.13
Timing TC004:000.14 — TC004:255.14
TC009:000.14 — TC255:255.14 -
Enable TC004:000.15 — TC004:999.15
TC009:000.15 — TC099:999.15
Preset - TP004:000 — TP004:255
TP009:000 — TP255:255
Accumulated - TA004:000 — TAO04:255
TA009:000 — TA255:255
Counter Coil Update Acc CC005:000.10 — CC005:255.10
File CC009:000.10 — CC255:255.10 LM
Underflow CC005:000.11 — CC005:255.11
CC009:000.11 — CC255:255.11
Overflow CC005:000.12 — CC005:255.12
CC009:000.12 — CC255:255.12
Done CC005:000.13 — CC005:255.13 -
CC009:000.13 — CC255:255.13
Down Enable CC005:000.14 — CCO05:255.14
CC009:000.14 — CC255:255.14
Up Enable CC005:000.15 — CC005:255.15
CC009:000.15 — CC255:255.15
Preset CP005:000 — CP005:255
- CP009:000 — CP255:255
Accumulated CA005:000 — CA005:255
B CA009:000 — CA255:255
Integer File N007:000.00 — N007:255.15 NO007:000 — N007:255
N009:000.00 — N255:255.15 N009:000 — N255:255
Floating Point File - F008:000 - F255:255 H/L
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